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Glossary of Hardware

9005: 4-port Powered USB Hub 9002: USB Cable

8206: Data Acquisition/Conditioning System 8208: PS2 (Mini-DIN) Ext, Cable

8215: Rat Cable (PS2) 8204: Mouse Commutator/Swivel



8214: Rat 8202: Mouse

8201: EEG/EMG Mouse 8239: EEG/EN

8201: EEG/EMG Mouse Headmount 8249: EEG/EN



Hardware & Driver
Installation

IMPORTANT: Before connecting this device to your PC, you
must install the USB drivers. See the accompanying USB
Driver CD and installation manual.

NOTE: If you purchased a computer with your video system, the
USB drivers and software are already installed.

Connect a 4-port powered USB hub to a wall outlet and to your
computer's USB port. This is necessary because energy saving
features on many computers will automatically shut off power to
the system when it deems it not in use.

Connect the 8206 unit to the powered USB hub with the provided
USB cable.

If the USB drivers are installed correctly, both the power and the
status lights on the 8206 will light up.

From your PC the hardware is connected in this
sequence:
. 4-port powered USB hub

USB cable

3-channel data acquisition/conditioning system

6-pin VGA cable

Swivel/Commutator

Preamplifier with cable

Headmount (see surgery protocol for attaching headmounts)



Software Installation

Download the latest version of PAL-8200 from our web site,
www.pinnaclet.com (recommended), or insert the CD into the
CD-ROM Drive.

Run PAL_8200_Setup.exe

Click on “Install” and follow instructions.



Mouse

Connect the PS2 cable between the 6-pin DIN connector
on the top of the commutator board and the 6-pin DIN
connector on the front of the Data
Acquisition/Conditioning System.

When you are ready to make a measurement, connect
the 6-pin rectangular header on the top of the
preamplifier cable to the 6-pin rectangular header on the
bottom of the commutator cable. BE CAREFUL: THIS
HEADER IS POLARIZED. NOTE: The preamplifier
end connects to the headmount; the cable end

connects to the commutator’s tether.

Always connect the two headers such that the markings
(normally white) are on the same side. Connecting
these backwards will short the preamplifier. This will
render the system unusable, but will not cause any
permanent damage. If the preamplifier is plugged in
backwards while the USB cable is plugged in, the 8206
power and status lights will either not be lit, or will be
very dim.

If you have the optional mouse test source, connect the
preamplifier to it to check your connections before
committing a mouse. The 6-pin connector on the
preamplifier should be to the bottom when connecting to
the test source. See picture.

EMG wires are to the posterior of the headmount. When
connecting the preamplifier to the mouse headmount
you will notice 2 small black squares on one side of the
preamplifier, and only one black square on the other
side. The side with one black square is anterior; the side
with two black squares is posterior.



Rat

Your commutator/swivel is already attached to an
aluminum mounting plate. You can use this
arrangement or remove them and create your own
custom arrangement.

Connect the commutator to the 8206 unit via the #8215
cable.

Connect the preamplifier to the red extension on the
bottom of the commutator (NOTE: the preamplifier end
of the cable should be at the rat’'s head. If you have the
model with the separate preamplifier, the preamplifier
connects to the rat headmount). You may want to see
Q13 in the FAQSs, if you are performing an extended
experiment.

If you have the optional rat test source, connect the
preamplifier to it to check your connections before
committing a rat. You will need to use the adapter cable
to connect the test source to the preamplifier.

8206 External Input/Output

The 8206 has 6 external I/O lines to enable external control and allow third party data acquisition systems
to use the 8206: a 5V output, a 5V input, a ground connection, EEG1 analog output, EEG2 analog
output, and EMG analog output. The signals need not necessarily be EEG or EMG; these are the
defaults for the 8206. The I/O lines are located on the top right of the 8206 and are labeled O1G123:
Output, Input Ground, Channel 1 (EEG1), Channel 2 (EEG2), and Channel3 (EMG). The figure below
shows the labels as seen on the 8206.

Connecting:

To use the 5V input or output, simply complete an input
or output circuit using the ground pin provided. The
output has a limit of 20 mA. The input has a weak pull-
down to ground. The EEG1, EEG2, and EMG analog
outputs have a range of 0 to 5V with signal center being
approximately 2.048V. This is after an x100 (or x10)
preamp gain and x50.78 amplifier gain. If controlling
the 8206 from a host computer the PGA gain settings
will NOT affect the signal, however the filter settings will.
Note: the inputs and outputs are ESD sensitive. Also
note: Voltages present on the inputs or outputs that are
outside of the 0 to 5V range could damage internal
circuitry.



New Experiment Setup

From your “Start” button, run “PAL-8200/PAL-8200 Acquisition”.

After launching the Acquisition software, a blank experiment
panel will appear (right). To start a new experiment, either
select “New” from the “File” menu, or simply click on the “New
Experiment” button.

A “New

Experiment” dialog will open up with parameter settings and a
list of EEG/EMG Systems that can be used in the new
experiment. An EEG/EMG System will not appear if the device
is already being used in an experiment, the device is not
connected, or if the driver has not been loaded. If the device
has not been plugged in yet, you can plug it in now and press
the “Scan” button to add it to the list.

Choose a USB EEG/EMG from the list of “Devices Found”.
Make sure the ID number in the list matches the ID on the label
of the 8206 to which you wish to connect.

If the 8206 has just been connected and does not appear in the
Devices Found window, press the Scan button to re-acquire the
hardware address.

If you receive the message, “unable to update configuration
information” go to “Upload Firmware” in the next section.

Experiment Name: Enter the name of the experiment in the
“Experiment Name” field. Insert additional information into the
Patient Info field, such as the ID of the mouse/rat connected to
the 8206. Enter where to store the data in the data file , or use
the “...” button to open a dialog for selecting the file to use. If no
directory path is given, the file will be placed in the install
directory for the PAL-8200 program. The default is:

C:\Program Files\Sirenia\

Next, enter the epoch length in the “Epoch Length” field. This
length determines how much data is stored before the data is
saved to disk. The length is later used for scoring. This
determines the length of a sleep stage. 10 sec. is the
recommended default.



The “Firmware Version” field shows the firmware version
running on the 8206.

In the “Sample Rate” field, enter the desired sampling rate for
all three amplifiers. Rates of 200, 400, 600, 800, 1,000 or 2,000
Hz can be selected. Once chosen, this rate is fixed for the
duration of the experiment.

Sampling rates and estimated disk space used are shown on
the table at right.

Setting the Gain

The Preamp Gain setting should correspond to your shipped
preamplifier unit. For mouse preamplifiers, the color-

coding band on your preamplifier will determine which
preamplifier unit you have (see below). For rat
preamplifiers, “SL” models have x100 gain; “SE” and

“SE3” models are x10.

IT IS IMPORTANT THAT YOUR PREAMPLIFIER GAIN
MATCHES YOUR DATA ACQUISITION SYSTEM, AND BOTH
MATCH THE GAIN YOU SELECT IN SOFTWARE.

Under Channel Gain , the digital amplification settings allow for
additional software gains of 1X, 2X, 4X, 5X, 8X, 10X, 16X and
20X amplification. NOTE: this is in addition to the hardware
preamplifier gain AND the main hardware amplifier gain (50.78
X).

Low Pass Filter Settings

Low pass filter settings may be adjusted between 11-
1000 Hz. These can both be adjusted once an

experiment has begun. Low pass filters are sth order
Progressive Elliptic and implemented in hardware. See
the table above for specific settings for the model type.

When done adjusting settings press the “OK” button and
data acquisition will begin.

TTL Events

There are 3 check boxes for TTL controls. The first two
enable rising and falling edge triggered TTL events.
When the TTL In line moves from high to low, falling

10

Disk space /
Rate SK Sp
animal / 24 h
200 Hz 125 MB
400 Hz 250 MB
600 Hz 375 MB
800 Hz 500 MB
1000 Hz 625 MB
2000 Hz 1.2GB
Unit Preamplifier Preamplifier | Filter settings
Description setting Color
8206 —SL EEG: X 100 Black/Black | EEG: 0.5 Hz
EMG: X 100 EMG: 10 Hz
8206 — SE EEG: X 100 Red/Red EEG: 1Hz
EMG: X 100 EMG: 10 Hz
8206 —SE3 EEG: X 100 RedBlack/Red | EEG: 1Hz
3 channels EEG
8206 -C Custom setting!
Std. cable lengtl| 18” total length
ral
Std. cable lengt(| 13" (swivel +
mouse preamp)




edge, or low to high, rising edge, an annotation will be
added to the recording. The TTL out controls the TTL
out line, checked indicates a high value on the TTL Out
line, and unchecked is a low value.

Uploading Firmware

If you have not already done so, open a new experiment. You
will see the window on the right.

Highlight the device you are using under “Devices Found”

The current firmware version for the 8206 will be displayed
(right)

If you receive the message “unable to update configuration
information”, click OK and proceed.

Make sure your PAL-8200 CD is in your CD drive, click

on “Upload Firmware” and find the firmware on your CD. It will
be on the main menu and read “M8206_Vx_x_x.hex”. You
can also download the most current version from
www.pinnaclet.com

Click “Open” and wait for it to download. This may take
several minutes.

Acquiring Data

The New Experiment dialog will be replaced by
the experiment window and a new experiment will
be placed in the experiment list. If an experiment
by the same name is running a unique number will
be added to the then end of the experiment name.
The current experiment will also be selecting
showing the single experiment view.

The “Experiments” list on the left of the window
shows all active experiments. You can toggle
between them by simply clicking the name of the
desired experiment in the list. The right side
shows the acquisition process of the currently
selected experiment. By default, data are not
being recorded to a file.

By pressing the Red “Record” button, recording will
begin, removing the “Not Recording” text.
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Once data recording has begun, the “Record” button
will change into a “Pause” button.

Pressing the “Pause” button will temporarily halt
recording of data to the data file.

Pressing the “Stop” button will end the experiment.

The “Start” and “Stop” buttons at the bottom of the
screen function as a stopwatch. They will
automatically insert start and stop events. The
display to their right gives the time of the event.

Multiple Experiments

When recording multiple experiments, animal
identification will be displayed in the left-hand window.
To select a specific animal to display, left-click on the
animal ID in the window

By selecting multiple experiments, either holding “ctrl”
and clicking on an experiment or pressing the “Select
All” button, they may all be viewed at the same time.
The plots are all pushed into single view of the data and
arranged on the right side.

NOTE: if you are running multiple experiments it is
suggested that recording on all 8206 units are stopped
at the same time. A new recording may be started
immediately after disconnecting an 8206 unit from the
system.

12



Plotting Tools

During an experiment, you can zoom in on the data as
they are acquired using the zoom tools located under the
Zoom menu or by using the magnifying glass shaped
buttons. Clicking on a tool will make that tool active and
deactivate any other current tool. Once a tool is selected
you can click and drag on any graph to select a region to
zoom to. To decrease zoom level select the appropriate
zoom tool and simply click on the graph. See table below
for a description of the tools. Alternatively, you can click
on the X or Y-axis scale numbers and change them
manually by typing in the new value.

Letting the mouse float over the plot will pop-up a
tool tip menu.

Right-clicking on the plot will bring up an array of
options (See image to the right and following table).

13
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Program Overview

The review program performs basic review
function for looking over collected data

To review a data file, open PAL-8200 score
program from the “Start” menu on your computer.

Open File: Clicking this icon will bring up the
Open File dialog, and allow you to choose a
previously acquired data set to open for scoring.
The data set will be loaded and shown in the Data
Windows.

Epoch Selection Tools

First: Moves to first epoch of the data set

Previous: Moves to the previous epoch

Previous Unscored : Moves to the previous
epoch that has not been score.

Next: Moves to the next epoch

Next Unscored: Moves to the next epoch that has
not been scored

15



Scoring Tools

These tools are used to score the currently displayed
epoch or group of epochs, depending on configuration
(see the Score menu below). An epoch is the shortest
time frame that can be scored. You can shorten the
length of your epoch in the new experiment dialog before
acquiring data. Options for scoring are:

Unscore: Removes scoring information

Sleep: Scores as Non-REM sleep

REM: Scores as REM sleep g

Wake: Scores as Wake |

Exclude/Include: Excluded from analysis. The ac
score of the epoch is unchanged.

Artifact, Noise or Bad Data: Scored as bad data. m

Plot Tools

No Tool: No tool is selected.

Zoom In X: Two vertical bars will be drawn that
show the area to zoom in on.

16



Zoom In Y: Two horizontal bars will be drawn that show
the area to zoom in.

Zoom Box: Zooms the graph in both the X and Y
directions. Click and drag to resize the graph window to fit
the selected region.

Zoom Out X: The X-axis will be zoomed out to 2x the
current window from the location the mouse is clicked.

Zoom Out Y: The Y-axis will be zoomed out to 2x the
current window from the location the mouse is clicked.

Auto Scale: The plot will be zoomed to the most
appropriately fit data. The Y-axis will have 10%
increases in height for better viewing; the X-axis will fit to
match the current data.

Auto Scale X: Zooms to fit all of the current values on
the x-axis.

Auto Scale Y: Zooms to fit all values on the y-axis.
This adds an additional 10% to the height for easier
viewing of the data.

17



Scoring Status Bar

the scoring status bar displays the current epoch score
along with the scores of the epoch both before and after.

The current epoch is always in the center, and the score
box is raised. Epochs are color coded by type except for
excluded epochs — they are shown as a darker shade of
the color that they have been scored as.

Epoch Information Bar

This bar is found in the upper left hand corner of the data
plot area. This area shows the current experiment name,
the current epoch being displayed, and the starting and
ending times of the current epoch.

Filter Controls

These controls are found to the left of your data graphs
and are used to set the filtering applied to the current
epoch. The filter to the right is only for modifying the
display; the underlying data is not changed.

Type: User selectable between High Pass, Low Pass,
and Band Pass settings

Order: Order of the filter. Higher values have sharper
frequency cutoffs

Low Frequency: The lower frequency of the permitted
band

High Frequency: The higher frequency of the permitted
band

18



Graphs

The graphs show the EEG1, EEG2, and EMG (or third
EEG) channel data in three separate graphs. They can
display data in either the time or frequency domains.
Each graph can be individually scaled in the X or Y
directions using the zoom tools or can be manually
scaled by clicking on the scale numbers and simply
typing in new values. The table below shows the right-
click options.

19



File Menu

The File menu allows the user to open, close, and export
data files.

Open File: Opens an EDF formatted data file for scoring
Close: Closes the current data file

Open Power Data File: Opens previous power analysis
file

Open Video: Open video (.avi) file for playback

Exit: Exits the scoring program

Export Menu

Comma Delimited: Exports the current data file in a
comma delimited CSV format. This is useful for
importing values into a spreadsheet program. CSV data
can be read by a wide variety of programs.

Epoch Range: Exports the selected epoch range to an
EDF data file. By default the epoch range will be the
entire range of the data file.

Time Range: Exports the selected time range to an EDF
style data file. By default, the time range will be the
entire range of the data file. Partial epochs may possibly
be exported in this manner.

Scores: Exports the scores of the data file to a text file

Axon Text File: Comma separated file with a header
suitable for use with the Axon

Sleep Sign: EDF format for use with Sleep Sign®
software

NOTE: The export function will NOT function with video
files. If an EDF file is shortened from the original it will
not synchronize correctly with the associated video.

20



Printing Files

Export to chosen file, as per "Export Menu” and print per
that program’s instructions.

The Score Menu

The Score menu allows the user to score the data, set
up the scoring range, and configure the keyboard
shortcuts for scoring. There are also scoring buttons on
the tool bar to accomplish these tasks.

Unscored: ldentifies the current epoch as unscored
Wake: Scores the current epoch as Wake

NREM: Scores the current epoch as Non-REM sleep
REM: Scores the current epoch as REM sleep

Artifact: Scores the current epoch as artifact, noise or
bad data

Exclude: Excludes or includes the current epoch from
spectral power analysis

1 Epoch, 5 Epochs, All Visible Epochs:  Sets the
scoring range; only one can be chosen at a time.
Whenever a scoring key is pressed, that score will be
applied over this range.

Key Configuration: This allows the user to change the
default keyboard shortcuts for scoring and navigation.
(See illustration on right)
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The Tools Menu

The tools menu allows the user to access a variety of
functions necessary for data review.

The Video submenu is for playback of associated video
clips and is covered in further detail in the Video section
at the end of this manual.

Jump To Menu

This menu allows the user to easily jump to locations in
the data file.

Next Unscored: Jumps to the next unscored epoch.

Previous Unscored: Jumps to the previous unscored
epoch. \

Next Wake, Non-REM, REM: Jumps to the next epoch
scored as Wake, Non-REM or REM.

Previous Wake, Non-REM, REM: Jumps to the
previous epoch scored as Wake, Non-REM or REM.

Next Annotation : Jumps to the next recorded
annotation in the data file

Previous Annotation : Jumps to the previous recorded
annotation in the data file.

Time: allows the user to jump to a particular time
location in the data file. Dates past the beginning or end
of the data file will jump to the beginning or end of the
file.

Epoch: Jump to any epoch number in the current data
set.

22



Zoom Menu

This menu mostly duplicates the Zoom Tools explained
above, but also adds some additional tools.

Y Zoom, X Zoom, X Zoom Out, Y Zoom Out, XY
Zoom: ldentical to the similar Zoom Tools.

Reset: Resets the zoom level back to default on all
graphs.

Set XY: Allows the user to manually specify the limits of
the displayed data on each channel.

Time Span Menu

This menu allows the user to set the length of time
displayed on the graphs. It does not change the epoch
lengths of the recorded data in the data file. This is
provided to make scoring easier by allowing the user to
score longer or shorter time periods as desired.

1 Epoch: Sets the displayed range to 1 epoch length

10s, 30s, 60s, 2min, 5min: Sets the displayed range to
the selected time duration.

Plot Color Menu

This is used to change the colors of the plot lines and
background.

To change the plot line colors, click on the color of the
trace you wish to change.

The Pen settings box will appear. Click on the Color box
and select the new plot color from palate.

Follow the same steps to change the background color.

23



Help Menu

This menu allows the user to access help
functions and view information about the
program.

About: Displays the current version of the
software as well as contact information for
Pinnacle.

24



PAL-8200 Video

(Optional module)

Included Hardware &
Software

Computer
Camera(s)
4" x 14” mounting plate

PAL-8200 Software (video version)

Video Capture of Experiment

If the video capture module has been purchased the
Capture Video box will be enabled. To capture a video
stream along with EEG signal collection, turn on this
feature by checking the Capture Video box.

If your system came configured with a pre-installed video
card, select the WDM/VFW video feed.

Press the button to select a directory and file to
save the video capture. NOTE: Video is stored
separately from the EEG file and will need to be re-
loaded for playback. It will be helpful to name the video
capture file in a manner similar to the main EEG capture
file for that animal.

Check the “Multiple Files” box if you would like the video
to be separated into multiple files instead of one large
file. You may select the length of the video files in the
“Time Between (min)” box. The File name will change to
“capture.avi.multi.” Make sure to retain the .avi.multi
extension if the filename is changed from the default
“capture”.

All video files saved in this format will be stored in the
same directory as the .avi.multi file. All of these files are
needed for correct video playback.

25



NOTE: Video enabled computers are shipped with two
additional hard drives. It is recommended when
capturing from both cameras simultaneously different
drives are selected for each video feed to avoid
overloading the hard drive bus during prolonged
recording.

In the Source: pull-down box, select the video feed
associated with the 8206 amplifier being used.

In the Compression: box, select the type of
compression to be used. Only Xvid MPEG-4 is currently
enabled so this must be selected for video compression.
For playback on a machine other than the recording
device, the Xvid codec must be installed. This program
may be found on the included CD-ROM or by
downloading from the web site www.xvid.org

Xvid compressed video will consume approx 1 GB of
disk space per hour of recording. This can vary highly
depending on the degree of animal movement.

When the video-enabled experiment is started, a box
displaying the current video feed associated with the
EEG channel will appear above the EEG signals. If you
are recording only one video channel the picture will not
update until EEG recording has been initiated.

Video Playback

NOTE: For video playback on a machine other than the
recording device, the Xvid codec must be installed. This
program may be found on the included CD-ROM or by
downloading from the web site www.xvid.org.

To playback an associated video with the recorded
waveform, first load the EDF file to be analyzed. Then
select Open Video File from the main File menu. Select
the video file associated with the EDF record.

If you have chosen to record multiple video files, open
the data folder and select the .avi.multi file instead of an
individual video file.

NOTE: It is a good idea to name the EDF file and
associated video (.avi) file or multiple file index
(-avi.multi) in a similar manner in order to ease later file
matching.

26



Once opened the video will appear as a separate
window. NOTE: For large video files it may take a
couple of minutes until the entire file has loaded.

Scrolling through each epoch the video preview will
update according to that epoch.

To view the real-time video associated with the epoch
waveform, select Tools, Video, Play from the dropdown
menu. A bar will scroll through the waveform and the
associated video will display in the window.

To continuously play the epoch select Loop from the
menu.

If a period of time longer than a single epoch is desired,
select a longer period from the Time Span menu.

In this configuration the current epoch is shown in the
center and video playback will commence from the left-
most epoch.

IMPORTANT: If you have synchronized video, updates
cannot be installed from the web site. Contact Pinnacle
Technology, 785-832-8866, for your free update CD.

27



$

(PAL-8200 v1.8.5 and later)

Open the Seizure Detection module by clicking on “PAL-
8200_Seizure” under the PAL-8200 folder in the
Windows START menu.

Loading and Viewing Seizure
Files

To open a file for analysis, select File, Open from the
top menu.

Select the file to open from the Dialog box and press
OPEN

The file will be displayed as shown below:

EEG channel #1 is shown as the top trace, EEG channel
#2 is in the middle and EEG #3 / EMG is the lower trace.

The time span displayed is 10 sec.

28



The plot tools operate the same as they do in the main
review program. See pages 18-19 of the PAL-8200
viewer manual for details.

To set the search criteria for seizure detection select:
Seizure, Seizure Parameters from the top menu.

This will bring up the “Find Seizure” dialog box.

Select the channels to search for seizures: EEG1, EEG2
or EMG

The following parameters may be adjusted to narrow the
search for seizure waveforms:

RMS Power: The average power over a time range
which seizures can be determined.

Min Duration : The length of time to average values.
This should be less than the minimum seizure duration.

Time Granularity : Amount of time to shift before starting
next calculation. This should be less than the Min
Duration. Larger values will yield faster search times
while smaller values will more accurately find the start of
a seizure episode.

Frequency Band : Frequency range to filter over.
Narrowing this parameter can help eliminate artifacts or
narrow the search for specific seizure waveforms.

To search for seizure events select “Seizure” from the
top menu and select “Find Next Possible .”

Or press the seizure button on the toolbar.

29



This will highlight the next possible seizure event in the
file.

Marking Seizure Events

To mark seizure events, right-click on the seizure and
select Add Annotation

Make any notes about the event in the Add Annotation
box and press OK. This will flag the seizure event for
access in future review sessions.
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A red line with the seizure notes will appear on the
record to indicate that the event has been marked.

Reviewing Seizure Events

Seizure events may be reviewed in either the PAL-8200
Viewer or the Seizure detection program. Load the
appropriate file, select the “Jump ” menu and select
“Next Annotation ” from the menu bar. This will move
the viewer to the next (or previous) annotation marker.
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Mouse Pinouts

View facing preamplifier

View from top of headmount
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Rat Pinouts

View facing preamplifier (looking at the pins on the end of
the preamplifier)

View facing head mount. Lines correspond to wires from
prefabricated unit. Pins correspond to 363 pedestal (top
view).

NOTE: For 3 EEG systems — replace EMGa with EEG3a a nd EMGb with EEG3b
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